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Training Schedule

10:00 a.m. Introduction
   Objectives

Overview 
   TTS vs. Human Narration
   Hardware and Software Players
   Determining Student Need
   Program Features

11:45 a.m. Lunch

1:00 p.m. Software Readers
Adobe Reader
Speaking Notepad
Read Please
TextAloud
Balabolka
WordQ
Dolphin Tutor
Kurzweil

2:30 p.m. Break

2:45 p.m. Key to Access
     Premier

DAISY
     Hardware players
     Software players

Hardware players
   Kindle
   Stream
   BookPort
   Classmate

4:30 p.m. End
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Affordable Reading Systems

Today there are many options available for reading digital text files. There are a 
variety of software applications and hardware devices that can read some form 
of digital text, and an equally large number of potential sources for digital text. 
In terms of  difficulty, trying to keep up with the technology used to play digital 
text is second only to trying to keep up with the different sources of digital text 
appearing on the internet every year.

Just what comprises a digital reading system can vary greatly, however. Beyond 
the desktop software applications available for low prices (if not free of charge) 
there are also dedicated hardware devices and the rise of mobile applications for 
smart phones and other portable devices.

While there are many reading programs and devices that are released every year, 
there are a number of applications that remain favorites among students and 
educators alike. We will try to present you with such examples for consideration 
in building your own AT tool chest for your lab and for your students.

This training has been created in an effort to help people stay on top of the dif-
ferent options available today for reading digital text. It is impossible to provide 
an exhaustive overview of every available tool out there, but hopefully you can 
get a better understanding of what is available for different price points. The 
expectation is that you can get a first-hand look at some of the technology being 
used today, and then you can determine whether the needs of the student are best 

met via desktop readers or by portable readers.

Sound Files

What is an MP3?
MP3 (MPEG-1 Audio Layer-3) is a patented digital encoding technology that 
has become the defacto standard technology and format for compression of 
sound into a very small file. The resulting file is commonly referred to as “an 
MP3” and files in the MP3 format have an extension of “.mp3”. MP3 technology 
is perhaps one of the more commonly known types of audio file from the collec-
tion of media formats used to distribute digital audio.

The goal of the MP3 format is to compress a sound file by a factor of 10 to 
14 without noticeably affecting the sound quality, allowing for greater storage 
capacity on hard disks and other storage media. The ability to compress the file 
size while preserving the original level of sound quality of the audio file is what 
has made MP3 music compression the most popular format for transferring, 
storing, and listening to music on the Internet.
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How does MP3 technology work?
There are two techniques that are used together to help compress the size of the 
sound file into an MP3 without losing noticeable sound quality:

•	 Perceptual noise shaping: The MP3 format uses characteristics of the human 
ear to design a compression algorithm. For example, there are certain sounds 
that the human ear cannot hear and certain sounds that the human ear hears 
much better than others. Using facts like these, certain parts of a sound 
sequence can be eliminated without significantly hurting the quality of the 
sound for the listener. 

•	 File compression. Compressing the rest of the sound sequence further shrinks 
the file size considerably.

Creating MP3 Files
In order to create an MP3 file, you will need:

•	 sound/audio source

•	 MP3 creation program

•	 storage space on hard drive or other media

In addition to the items listed above, you will also need to make sure you have 
access to an MP3 encoder codec, which unfortunately does not always come 
included with software that can create MP3 files. A popular MP3 encoder used 
by many MP3 creation programs is the “Lame.dll” encoder. You can read more 
about the Lame encoder at: http://lame.sourceforge.net/.  
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Balabolka 2.02

Balabolka is a Text To Speech (TTS) program for Windows that provides realtime 
playback of digital text files, and also produces recorded audio files that can be 
played back on other devices, such as MP3 players. Balbolka is a Russian word 
that translates as “chatter”.

Balbolka Splash Screen

Key Features
Digital text can be saved as a WAV, MP3, MP4, OGG or WMA file. Balbolka also 
reads the Windows clipboard content, and can display text from CHM, DjVu, 
DOC, EPUB, FB2, HTML, ODT, PDF and RTF files. There is support for cus-
tomized font and background colors. Users can control reading from the system 
tray or by the global hotkeys.

System Requirements (Version: 2.2.0.498)
Operating System: Microsoft Windows 2000/XP/2003/Vista/7

Program size: 6667 KB

Licence: Freeware

Supported Languages:	English, Bulgarian, Chinese (Simplified), Chinese (Tradi-
tional), Czech, Dutch, French, German, Hungarian, Italian, Korean, Polish, Por-
tuguese (Brazil), Portuguese (Portugal), Romanian, Russian, Spanish, Ukrainian, 
Vietnamese. 
Help Files: English, French, German, Korean, Russian, Ukrainian.
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Balabolka Interface Overview
Balabolka provides a straightforward and simple to use interface. With traditional 
Windows interface elements like a “File” menu, most Windows users should 
feel comfortable using the program. Do note, however, that instead of the word 
“Help”, Balabolka presents the user with a question mark “?” for the help menu. 

Beneath the text-based menu structure there is an icon-based menu that allows the 
user to control the essential elements of the program. By default, there is a control 
panel for the TTS voices used by Balabolka immediately beneath the icon-based 
menu.

Balabolka Main Interface

MAIN CONTENT WINDOW

TTS Control Panel

Icon-based Menu

Finally, beneath the TTS control panel, you can find the main content window.

Beneath the Main Content window is a status bar where you can see the details of 
what is currently in the Main Content window, including the file name and loca-
tion on the hard disk, the cursor position, the TTS voice being used, and the file 
size.

Loading Files
To open a file in Balbolka, open the “File” menu and select the option to “Open” 
(CTRL+O), “Reopen”, or create a “New” file (CTRL+N).  Balabolka’s file menu 
provides the user with many options in terms of what types of files to open, and 
even more options for saving out different file types.
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Balabolka supports .txt, .html, .doc, .docx, .epub, .pdf, .odt, .rtf, .chm, .fb2, .djv, .rar, 
and .zip files. Balbolka saves files as .bxt.

Balbolka File Menu
You can also paste information from the Windows clipboard into the Balbolka 
speech window.

Saving Files
Balabolka allows the user to save text files and “Balbolka Text Files” (.bxt), as 
well as saving out audio versions of the content.

Balabolka will save out to the following audio formats: .wav, .mp3, .wav, .ogg, 
.wma, .mp4, .m4a, .m4b, .awb.

Splitting Audio Files
Balabolka also lets the user split their text files into smaller pieces in order to cre-
ate more manageable audio files.

Balabolka Split and Save Audio File Window
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Users can selcct from a a variety of options to control at what point the file is 
split, and designate where to save the resulting audio files. File names can be set 
to automatically increment either before or after the file name.

ID3 Tags
Users can supply meta-data about the file via ID3 tags, including the ability to 
embed a digital transcript of the audio file into the audio file itself (depending on 
file format - for example, .wav does not support ID3 tags).

Information available in the ID3 tagset include Title, Artist, Album, Year, Genre, 
Comment, Track #, Composer, Encoded by, Copyright, URL, and of course a 
text field for transcript or lyrics.

Balabolka ID3 Tag Editor
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Playing Files
Balabolka allows the user to playback audio from text files loaded into the main 
interface. Audio is generated by the computer’s TTS voice technology, using 
either SAPI 4 or SAPI 5. 

NOTE: In order to support multiple languages in a single document, SAPI 5 must 
be used.

Balabolka Speech Menu

Users can control the play-
back of audio via the Speech 
menu within Balbolka. Avail-
able commands include basic 
playback, pause, and stop, as 
well as incremental controls to 
navigate through the content.

Speech Menu Command 
Read Aloud

Keyboard Shortcut
F5

Pause F6
Stop
Read Selected Text

F7
F8

Read Clipboard Aloud
Skip to Next Paragraph
Skip to Previous Paragraph

F9
CTRL + DOWN ARROW
CTRL + UP ARROW

Program Options
Balabolka offers many different options for 
configuring the program interface and the 
different aspects of handling digital text 
files and converting them into digital audio 
files.

Pronunciation Correction

Balabolka provides the user with the ability 
to create multiple pronunciation profiles and 
the ability to search for different instances 
of words and rules alike.

Balabolka Options
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TTS Options

Control the speed, pitch, and volume of the audio generated by Balabolka. Users 
can also reset the audio settings to the default values.

Audio Files

Users can configuure the details of the recorded audio files made by Balabiolka 
through the Audio Files Settings dialog.

Balabolka Audio Files Settings Dialog

Settings Options
Balabolka features a rich Settings panel under the OPTIONS menu. There are 
twelve tabs in the Settings panel, which allows the user to configure and control 
all of the critical aspects of running Balabolka. 

The different tabs of the Settings panel are labeled:

•	 General - allows you to select the options of where reading should begin 



Affordable Reading Systems

HTCTU • 2011	 13

(cursor, beginning of text, beginning of paragraph), as well as where the 
recording should begin. Behavior for how the program should operate upon 
startup and while minimized, as well as text echo parameters are controlled in 
the General tab.

•	 Reading - provides options to configure reading behavior at line breaks and 
end of file, configure compatibility with screen reading applications, the 
ability to track spoken text, and how to track the spoken text (centered or fit to 
limits of window).

•	 View - configures the look of the interface, and controlls what sort of data is 
presented. Selections to show the status bar and what to include in the status 
bar are found here.

•	 Pauses - allows the user to configure the length of pauses during reading 
and recording audio. Also allows user to specify the length of time between 
recorded audio tracks.

•	 Text - the user can controll whether the text will be formatted automatically or 
not. Allows for the automated cleanup of text files, such as removing double 
line breaks, hyphens at end of lines, and line breaks within paragraphs. Also 
allows for advanced control of space-related issues in layouts, and different 
types of bracketed text.

Balabolka General Settings Dialog

•	 Hotkeys - hotkeys allow the user to configure the primary reading controlls 
and to determine if they are active or not. Users can map their own custom 
keystrokes for functions like read text, read from clipboard, stop, pause, 
increase or decrease rate, change pitch, etc. 
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•	 Shortcuts - in the Shortcuts tab you can create or change keyboard commands 
for any of the menu functions in Balabolka.

Shortcuts Dialog from the Settings Panel

•	 Buttons - user can determine which buttons to have visible on the icon-based 
menu bar, and change their position and grouping on the menu bar.

•	 Files - allows the user to configure which application to use when importing 
text files. Typically there is a built-in converter that works fine, but if the user 
wants to use a different application, they can make that selection here.

•	 Rules - the Rules tab features pronunciation settings to control how Balabolka 
will present the audio phrasing of the text it reads. The settings can be 
changed from sentences to paragraphs or a combination thereof in order to 
deliver a more natural-sounding delivery of the spoken words.

•	 LRC - Balabolka can also generate an LRC file for use in other digital audio 
players. The LRC file contains the digital text and timing information, so that 
the visual text can be presented at the same time as the spoken audio of the 
text.

•	 Voice - The Voice tab allows the user to select between SAPI 4 or SAPI 5, or 
to use the voice settings from the last document.

Under the Options menu, Balabolka also provides options for configuring the rate, 
pitch, and speed of the voice, as well as spell checking, and timers for turning the 
program off after it finishes generating audio files.

Tools



Affordable Reading Systems

HTCTU • 2011	 15

Balabolka also features several tools that enable the user to perform powerful 
operations on their digital text files.

File Splitter

Balabolka will split one long file into smaller files.

Batch File Converter

Balabolka will convert multiple files into audio files.

Extract Text from Files

Balabolka will load selected files and extract the text into a directory specified by 
the user.

Compare Two Files

Compare Two Files Dialog

Balabolka will compare two different files and allow the user to find text that is:

•	 present in both files

•	 present in one of the files only

•	 present in first file and absent in second file

•	 present in second file and absent in firsty file

•	 present in files (sum of files)

•	 enrich the reading and educational experience of the user.

Repeat Text

Repeat Text will allow a user to specify text that can be repeated throughout the 
document as a memory aid, or as part of attempted remediation of memory and 
recall issues.
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List of Spelling Errors

Balabolka will present the user with a list of all the mis-spelled words in a docu-
ment, to serve as a study aid.

Translate

Balabolka can translate between languages, taking advantage of the Google trans-
lation engine. The Google engine provides many different languages to choose 
from.

Translation from English to Russian in Balabolka
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Text Aloud

How do I prepare a file so I can convert it to the MP3 for-
mat?

Step 1: Create a profile for each student

With text-to-speech technology, there are many variants such as the playback rate 
and the synthetic voice of the text that is read back. It is important to find the best 
fit for the student using the audio file. Even with the same student, he or she may 
prefer that certain subject matter be read at a different rate or in a different voice 
than other subject matter. Before creating MP3 files for your student, set some time 
so that you and the student can listen to the different synthetic voices and differ-
ent reading speeds. It would also be a good idea to keep track of different students’ 
preferences in a document so that you do not need to consult the student every time 
you want to create an MP3 file for him or her. Here is an example table:

Name Subject matter/ 
Textbook

Voice Reading 
Rate 
(Words/
Minute)

Encoding 
Rate

Notes

John Doe The American 
Experience

“Jennifer” 150 32 kbps 
(mono)

Uses a 
screen 
reader

John Doe The Art and 
Science of C

“Mary” 100 48 kbps 
(mono)

Uses a 
screen 
reader

Amanda 
Hugnkiss

Alice in 
Wonderland

“Mike “ 200 32 kbps
(mono)

Step 2: Prepare the document and save as .txt, .doc, .rtf, .html, or 
.pdf file

As of Version 2.0 of TextAloud MP3, your file can be opened directly in the .txt, 
.doc, .rtf, .html or .pdf format. If your file is not in one of these formats, you will 
need to re-save the file in one of the accepted formats.

Step 3: Set up the pronunciation editor

The Pronunciation Editor allows the user to specify how TextAloud will pronounce 
words. In general, the synthetic voice reads most words correctly, but it may 
mispronounce certain words, such as acronyms, names, or other unique words. To 
change how TextAloud pronounces a word, you can follow these steps:
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1.	 Go to Options and select Pronunciation Editor. 

2.	 A new window will appear with a text box labeled Word. 

3.	 In the Word text box, add the word that you want TextAloud to correctly 
pronounce. 

4.	 In the Pronunciation text box, type in the word in such a way so that when 
you click the Test button it sounds correct (Hint: Try to spell the word 
phonetically.) 

This will change the way the word is read in all applications that use text-to-
speech. 

Step 4: Set up predefined pauses.

When some documents are read, they need pauses in them. TextAloud allows you 
to add predefined pauses to a document. To set up the predefined pauses, go to 
the Options menu and select Pre-Defined Pauses. A window will appear with two 
input boxes that allow you to edit two pause intervals, a Short Pause interval and 
a Long Pause interval. The number values are in seconds, so if you were to put 
2.5 in the Short Pause interval and 4 in the Long Pause interval, TextAloud would 
pause for 2.5 seconds at a given location at which you inserted a Short Pause 
interval and for 4 seconds anywhere you inserted a Long Pause interval 

To insert the pause intervals, right-click with your mouse where you want a 
pause inserted. Then, select Insert Short Pause or Insert Long Pause. After insert-
ing the pause, TextAloud will insert a string of text into the document. The text 
inserted will look like this:

“ {{Pause=x}} “

with a blank space between the string. The value of x will be a number that tells 
TextAloud to pause for x seconds. 

After I have prepared a file, how do I create an MP3?

Once your electronic text document has been prepared, you are ready to create 
an MP3 file. 

TextAloud MP3 is one software program that uses “Text-to-Speech” technology 
to record text information to an audio format. You can create ordinary .wav files, 
or save the output in compressed MP3 format. You can create MP3 files from 
your word documents, email, news articles, or any text you want, and download 
the content to your computer or portable MP3 player. TextAloud is developed by 
NextUpTech. The software can be purchased for $29.95 (per user). 

More information about the software can be found at http://www.nextup.com 

 Step 1: Open the plain-text file in TextAloud. 
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You can do so by going to the File menu and selecting Open, or by pressing Ctrl + 
O. 

Step 2: Select a file title.

After opening the text file, you will need to select a name for the MP3 file you are 
about to create. (You can change the name later if you want to.)

Step 3: Pick the synthetic voice that you would like to read 
the text file. 

To select a synthetic voice, go to the Voice dropdown menu of TextAloud and use 
the Speak button or Ctrl + F3 to get a sample of what each voice sounds like.

Step 4: Set the rate of the synthetic voice. 

The rate refers to how many words per minute (WPM) will be read. Again, you 
should consult the student for whom the MP3 is being created to ensure your set-
tings are producing the desired results. To configure the rate of the synthetic voice, 
use the Speed slider in TextAloud. To hear the current rate setting of the synthetic 
voice, press the Speak button or Ctrl + F3. 

Step 5: Set the encoding rate. 

The encoding rate can be changed in the Voices and File Options window. To open 
the Voices and File Options window, select Options Menu, then select Voices and 
File Options, and then select the File Options tab. The file output can be saved in 
.wav, .mp3, or .wma file formats. If you pick the output to be .mp3, then you need 
to decide the encoding rate you want for the MP3. The encoding rate is anywhere 
from 16 kbps to 128 kbps. The frequency ranges from 11.02 kHz to 48 kHz. You 
can also select mono or stereo sound. The lower the encoding rate, the lower the 
sound quality and the smaller the file will be. The same is true about recording in 
mono sound, which will result in a file about half the size of a stereo encoded file 
with the same bit rate. 

Step 6: Set the Write-to-File speed. 

This option is under the File Options tab of the Voices and File Options window. 
The larger the number is, the faster the MP3 will be created. However, the greater 
speed will also place a greater demand on your computer’s processor. If you have 
an older computer or have other applications running while you are creating the 
MP3 file, it is recommended that you keep the write-to-file speed around 10x.

Step 7: Select a file output directory. 

The File Output Directory is where the finished .mp3 or .wav file will be stored on 
your computer. It is located in the File Options tab of TextAloud. 
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Step 8: Create the MP3 file. 

The MP3 file can be created by pressing Ctrl + F7 or by pressing the button with a 
play button and disk image on it. 

 There is a status bar in the lower right-hand corner of the TextAloud window that 
will show you when the file is done being created.

How do you create multiple MP3 files in TextAloud?
With TextAloud you can create many MP3 files simultaneously instead of having 
to wait for each file to complete. This section discusses the steps to do this.

Step 1: Change the settings from Single Article Options to Multi-
Article Options. 

To do this, go to Options on the menu bar and select “Multi-Article Options”. You 
can also do this by clicking on the “Multi” button.

Step 2: Set voice and file output options. 

The Multi-Article setting can be controlled in the Article Options tab of the MP3 
Options window. The Multi-Article Options tab has two menus with radio buttons 
options: 

a.	 The Voice Selection Menu has three options Default, Random and Round 
Robin. 

•	 When the Voice Selection Menu is set to Default, all the documents will be 
read with the default synthetic voice. 

•	 If Random is selected, TextAloud will pick a random synthetic voice to 
read the documents. 

•	 Round Robin will cycle through all the voices that are available to 
TextAloud and will use a different voice for each document that you have 
open. 

b.	 The File Output Menu has two options: Single File and Multiple Files. 

•	 When Single File is selected, all the documents that are open in TextAloud 
will be read and combined into one single file. 

•	 When Multiple Files is selected, an individual MP3 will be created for 
each of the documents that are open in TextAloud. An advantage of the 
Multiple Files option is that you can, for example, create individual MP3 
files that correspond to chapters or sections of a book. Having an MP3 
file for each chapter will allow the student to more quickly navigate their 
reading material than it would be if all of the information was contained in 
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one large MP3 file. 

Step 3: Open the text files to be created into MP3s

Go to File on the menu bar and then select Open Text File (or press Ctrl + o) select 
the files that you want and repeat this step until all the text documents you want are 
open. 

Step 4: Repeat steps 3-8 for creating a single MP3 file in TextAloud.

How can you use the File Splitter Utility in TextAloud MP3?

As of version 1.446 of TextAloud MP3, Nextup.com added a utility to TextAloud 
MP3 that can be used to split files into smaller files. One limitation of earlier ver-
sions of TextAloud MP3 is that if you had one large e-text file, converting it to MP3 
format resulted in a file that was large and hard for the user to navigate. A good 
example is to think of trying to create an MP3 file for a 200-page chapter of a text-
book. The MP3 file that would be created in TextAloud would be over an hour and 
hard for the student to navigate within the chapter. A way to alleviate this problem 
is to split the e-text of the chapters of the book into smaller files so you can create 
many small MP3 files. With small MP3 files, the user can easily navigate within the 
chapters of the textbook.
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Users have two options for determining how the file will be split into multiple 
smaller ones. The first option is to specify a target size for each of the small files 
in kilobytes. The second option is to set-up a list of defined characters (delimiters) 
that will split the file each time that they occur in the document. The following 
steps will walk you through the instructions for either set-up

Step 1: Open the File Splitter Utility in TextAloud MP3 and select 
the input file name. 

In TextAloud MP3, go the menu and select File, File Splitter Utility. In the Input 
File Name, type the name of the file or select the Browse button to search your 
computer for the text file that you want to split into smaller files. 

Step 2: Select the directory where you want the split files to be 
stored. 

In the Output File Directory, type the path of the directory or select the Browse 
button to specify where the split files should be stored on your computer.

Step 3: Set the starting output file sequence number.

The Starting Output File Sequence Number is the starting number that the split 
files will be named. For example, if you have a large text file called Alice.txt 
and you set the Starting Output File Sequence Number to 4, the split files will be 
named Alice_004.txt, Alice_005.txt and so on. 

Step 4: Select the split method.

As described earlier, there are two way to split a text file. To split them by output 
target file size, set the size (in kilobytes) that the File Splitter Utility will split the 
input file into. To split the larger file by specified strings in the input file, specify a 
list of delimiters which can be set in the comma delimited list of strings text box.

Step 5: Preview and split the input file.

Select the Preview button to display how many files the input file will be split 
into. Select the Split button to complete the process.

How do I change voices within a single article in TextAloud 
MP3?
As of version 2 of TextAloud MP3, Nextup.com added the ability to change voices 
within a document. This is helpful when creating audio from documents that have 
more than one language in the text. An example would be a foreign language text-
book where English and anther language are intermixed in the text.

The ability to switch voices within a text works only with SAPI 5 compliant 
voices. To find out which SAPI 5 voices you have installed on your computer, go 
to the Options menu, select the Files and Voices Options, and select Use SAPI 5 to 
find out what voices are SAPI 5 compliant. 
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Step 1: Select the location where you want to change voices

While viewing the document in TextAloud MP3, move your cursor to the location 
right before you want the voice to be changed.

Step 2: Adding the voice tag to the text

Right click on the cursor and select Insert Voice Change and select the voice that 
you want to use. You can also do this by selecting Insert Voice Change from the 
Edit menu.

 Step 3: Select next location in the text where you want the voice to 
change

Select the next location in the text where you want the voice to change. Repeat 
Step 2.
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Adobe Reader 9

Publisher:

Adobe Systems Incorporated (http://www.adobe.com)

Retail Cost: 

Free Download

Tools and Toolbars
One big downside of Adobe Reader is that you can only access the tools that 
were enabled when the PDF file was created, unless you have the full version of 
Adobe Acrobat Professional installed. The tools that are particularly problematic 
in this regard are the comments tools. You can only access the comments tools 
in Adobe Reader (without Professional installed) if “document rights” has been 
enabled.

Unfortunately, if the originator of the PDF file did not have the comments 
enabled at the time the file was created, you cannot turn them on in Professional 
for later use with the Reader. The user will have to have Professional in order to 
use the comments tools.

Assuming you have Professional or a PDF in which comments have been 
enabled, set the toolbars to allow easy access to the comments features.

View > Toolbars (Alt V, T) 

I recommend starting with the following toolbars showing:
	 Comment and markup
	 Find
	 Page Display
	 Page Navigation
	 Select & Zoom

Reading Settings
Select the preferences menu (Ctrl + K) and then select Reading from the 
Categories list to set the reading preferences, including the voice and the speed. 
Note that the default speed is 190, which may be slow for readers who are used 
to listening to books.
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Please note that although you can, in theory, use any of the voices installed in your 
system, I found that using anything other than the default voice on my machine 
resulted in the program crashing. I have a lot of assistive technology on my system. 
Your experience may vary.

Reading Commands
The reading commands are (somewhat non-intuitively, in my opinion) under View. 
Such being the case, it would be good to teach your students the keyboard shortcuts.

Shift + Ctrl + Y = read the text in currently selected text area (shown with a box)  
	 Note that with this option selected, clicking on a new textbox will read that 
box 
	 Also note that using this keyboard command again will deactivate the 
reading.
Shift + Ctrl + V = read the current page
Shift + Ctrl + B = read to end of document
Shift + Ctrl + C = pause reading

Although Adobe will verbalize the text, it does not track or highlight where it is 
reading. It will continue to read past what can be seen on the screen.

Please note that Shift + Ctrl + E = ends reading; however, this is also the keyboard 
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command to launch Dolphin Easy Reader. If you have both installed, you will 
have a keyboard conflict.

Accessibility
Adobe Reader allows a number of nice accessibility features, including changing 
the color of the text/background and choosing the zoom setting. To access these 
features, choose Preferences (CTRL + K) and select Accessibility from the 
Categories list.
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White text on blue background at 200% zoom:

Encourage low vision users who wish to work with enlarged text to use the 
keyboard commands. (All commands found under the View > Zoom menu.)

Ctrl + Y = zoom to (set the magnification level)

Ctrl + 0 = Fit Page
Ctrl + 1 = Actual size
Ctrl + 2 = Fit width
Ctrl + 3 = Fit visible
Ctrl + 4 = Reflow

Reflow is an exciting feature that shifts the text on the page to eliminate the need 
for excessive scrolling. Below is an example of 800% zoom with reflow on.

To use the full screen for reading use the keyboard command CTRL + L.
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Bookmarks
Use the keyboard command Ctrl + B to insert a bookmark. You can name the 
bookmark. Selecting a bookmark returns you to the point in the text at which it 
was created.
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1st Read it Aloud!

1st Read it Aloud! is an affordable reading system that embodies the minimal-
ist approach to reading applications. It can be difficult to know that 1st Read 
it Aloud! is even running, as it has no dedicated program window. Instead, 1st 
Read it Aloud! installs into the system tray of your Windows machine. In order 
to bring up the 1st Read it Aloud options panel, you have to find the icon in the 
system tray or know the keyboard shortcut command (CTRL + F11)

System requirements:

Windows 98 or later operating system.

3.22 MB free disk space

Cost:

$19.95 US

Publisher:

Qwerty Studios

http://www.qwertystudios.com/products/1st-read-it-aloud/

Options
In order to bring up the options panel for 1st Read it Aloud!, press the keyboard 
combination CTRL + F11. The following dialog will appear:

1st Read it Aloud! Options Panel
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Using 1st Read it Aloud!
Because 1st Read it Aloud resides in teh system tray, the entire program is 
driven via keyboard commands. 

Reading Text

To read text with 1st Read it Aloud!:

Select the desired text you want to be spoken (from any application)

Press CTRL + Backspace to start reading.

Pausing Reading

Press CTRL + F12

Resuming Reading

Press Ctrl + F12

Pronunciation

You can access the pronunciation editor from the Options Panel of 1st Read it 
Aloud! by clicking on the “Pronunciation Editor” tab:

Pronunciation editor of the options panel in 1st Read it Aloud!
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Kurzweil 3000

If you scan to TIFF, you can create KESI files for your students who use Kurzweil 
by running the files through the K3000 automater. The automater has been 
included with the Kurzweil 3000 Professional (formerly called Scan & Read) 
stations since version 7. You must manually install the automater by dragging it 
from the “Extras” folder on the installation disk to your computer.

The automater allows you to create a source folder of TIFF documents that the 
Kurzweil 3000 will convert automatically to KESI files and save into a destination 
folder, keeping whatever file hierarchies you had set up intact.
Steps for converting TIFF files to KESI with the automator.

Before you start using the K3automator, copy it off the Kurzweil 3000 CD ROM 
to your computer’s hard drive. The K3automator is located on the Kurzweil 3000 
CD ROM in the Extras directory. The files that you want to copy to your hard 
drive are K3Automator.exe and K3Automator.chm. 

Make sure that the version of Kurzweil 3000 installed on the computer is 
Professional (scan and read). To check this, open Kurzweil 3000, and in the menu 
bar, select “Help,” “About.” A window should pop up telling you what version of 
Kurzweil you have.

Step one: Create a directory called “TIFF files” on your desktop and copy the tiff 
files from the CD ROM to that folder. This will help speed up the process.

Step two: Create a directory called “KESI files” on your desktop. This is where 
the completed KESI files will be located.

Step three: Start the K3Automator and set the Source and Destination directories. 
To start the K3Automator double click on K3Automator.exe. Then set the Source 
Hierarchy to the “TIFF files” directory, and set the Destination Hierarchy to the 
“KESI files” directory.

Step four: Click on the “OK” button on the K3Automator. This will start 
converting the TIFF files.

Step five: Wait. Once all the files have been converted, the K3Automator will stop.

Step six: Burn the file in the “KESI files” directory to a CD ROM.
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You can edit KESI files in a number of ways.

If the document does not begin on page 1, you can align the document numbers 
with the Kurzweil page numbers by going to View > Page > Set page number,

Remember that with Kurzweil 3000, you see the TIFF file on the screen, but it is 
the hidden, underlying text that the program actually reads. You can view and edit 
this underlying text by right clicking on the text and choosing “Edit underlying 
text.”
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The text on the page is set up in “zones.” Zones affect what text is read and the 
order in which it is read. You can view and edit these zones by choosing Tools > 
Zone Editor or using the shortcut key CTRL + F5.

If you click once to highlight a zone and then right click on that zone, you can 
change the reading order or other zone properties.
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The reading order is the order in which text is read. Zone one is read first, etc. You 
can also select whether the text will be read automatically (primary text) or only if 
the user clicks on the text (secondary text). Setting the zone type as graphic means 
that Kurzweil will not try to read that zone.

DAISY/NISO Standards

DAISY/NISO
http://www.loc.gov/nls/niso/dtbook3doc.htm

DAISY (Digital Audio-based Information SYstem) Consortium
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The Digital Talking Book 3.0 Document Type Definition (DTD) provides 
the means to markup the text of a published book to permit support for the 
combination of professional narration, and navigation into that narration. The 
markup tags in the book convey its content in structure, and some metadata about 
the book content and its structures.

NISO (National Information Standards Organization) 
http://www.niso.org/commitaq.html

Description of Standard: Currently, talking books for the visually impaired are 
distributed on audio cassettes. The next-generation technology for this application 
will be digitally based, bringing many improvements in sound quality, document 
navigation, and searching. The NISO Digital Talking Book (DTB) Standard will 
ensure compatibility among the many systems expected to be developed. The core 
of the standard will be the file specification, describing how the various functions 
of a DTB will be coded. Other portions of the standard will address the features 
desired in a DTB and describe the critical elements of the user interface of a DTB 
player. 

XML (Extensible Markup Language)

DTB consists of three major parts: an audio file, which could be encoded in 
any of several standard audio codecs (compression/ decompression algorithms 
that allow enormous audio files to be greatly compressed); a text file (necessary 
for word spelling and text searches) with tags from a descriptive markup 
language inserted—XML (Extensible Markup Language); and a linking file that 
synchronizes the audio and text files, probably written in SMIL (Synchronized 
Multimedia Integration Language).

NFF (National File Format)
Publishers, individuals with print disabilities, and e-text service providers all 
recognize the need for a standardized format for producing electronic text. Under 
the auspices of the Department of Education, ANSI/NISO Z39.86-2002 DTBook 
has been adopted as the national file format.
The following description is taken from the CAST Web site: 
http://www.cast.org/ncac/index.cfm?i=3192
In describing DTBook, the “pizza” metaphor has been used to clarify 
the use of the base tag set and additional modules. One can think of 
the DTBook tag set as being a basic cheese pizza, and modules as 
toppings that can be added as desired. The DTBook tag set contains 
the common elements found in textbooks and reading materials used 
in the K-12 arena. The over arching structures, such as front matter; 
headings for parts, chapters, sections, and sub-sections; rear matter, 
etc. are defined. Block-type elements, such as paragraphs, block 
quotes, lists, footnotes, sidebars, etc. are also defined. Inline items, 
such as emphasized text, acronyms, citations, footnote references, 
sentences, etc. are identified. A complete list of these can be found 
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in the standard. The point here is that the basic types of books can 
normally be represented in XML using this basic cheese pizza.

Now think of separate modules that can be added, as toppings on 
a pizza. A poetry module that would contain the tags needed to 
mark up poems is under development by the Z39.86 community. 
The community has also done preliminary work on a module for the 
markup of plays. These might be considered green peppers and 
onions for the pizza. The modules that can be added to the basic 
structure depend on the information one needs to convey.

The World Wide Web Consortium (W3C), the standards setting 
body for the Internet, has used this modular approach as well. One 
topping we may consider adopting for our pizza is the work they 
have done with MathML: http://www.w3.org/Math/

This is a module we should consider using when providing 
information in the field of mathematics. This is definitely meat on the 
pizza! The work conducted in the W3C paid close attention to the 
needs of persons with disabilities, but there is a lot of work, requiring 
significant resources, that needs to be done with accessibility tools 
to take advantage of math provided in XML in this way. The math 
work has been discussed by the Z39.86 Advisory Committee, and 
we have demonstrated that a MathML segment can be incorporated 
in a DTBook document. 

Other modules will be required as time goes on, such as for other 
scientific disciplines, dictionaries, music, and so forth. The DTBook 
DTD was designed to meet the majority of the markup needs in non-
technical books. It was deliberately kept lean so it would be easy 
to learn and use. The other modules to be developed would only 
be used as needed, thus minimizing complexity for users. DTBook 
incorporates a simple XML mechanism, described in section 4.2.2 of 
the standard and in the DTD itself, for incorporating tags from other 
element sets as needed
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Sources of E-text
4Literaturenet http://www.4literature.net/
Alex Catalogue of 
Electronic Texts

http://www.infomotions.com/alex/

Arthur’s Classic Novels http://arthursclassicnovels.com/arthurs/search.html
Audio Books for Free http://www.audiobooksforfree.com/
Baen Free Library http://www.baen.com/library/
Bartleby http://www.bartleby.com/
Bibliomania http://www.bibliomania.com/
Blind Bookworm http://www.panix.com/~kestrell/sources.html
Bookshare http://www.bookshare.org/
Camera Obscura http://www.hicom.net/~oedipus/etext.html
Caravan Project http://www.caravanbooks.org/
Christian Classics http://www.ccel.org/
Classic Bookshelf http://www.classicbookshelf.com/
Classic Reader http://www.classicreader.com/
Digital Library—Online 
Books

http://digital.library.upenn.edu/books/

E-Editions—University of 
Nebraska Press

http://www.nebraskapress.unl.edu/e_editions.html

English Server http://eserver.org/
Etext Archives http://www.etext.org
Fiction Wise http://fictionwise.com/
Free Books http://www.free-books.org/
Hoover Institution http://www-hoover.stanford.edu/publications/

books/
Institute for Learning 
Technologies

http://www.ilt.columbia.edu/publications/digitext.
html

Internet Public Library http://www.ipl.org/
Internet Public Library http://www.ipl.org/
LiteralSystems http://literalsystems.com/abooks/index.php
National Library Services http://www.loc.gov/nls/
NetLibrary http://www.netlibrary.com/
Online Books Page http://digital.library.upenn.edu/books/
Online Literature Library http://www.literature.org/
Planet eBook http://www.planetebook.com/
PoemHunter http://www.poemhunter.com/eBooks/
Poetry Portal http://www.poetry-portal.com/index.html
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Project Gutenberg http://www.promo.net/pg
Representative Poetry 
Online

http://eir.library.utoronto.ca/rpo/display/index.cfm

Revealweb http://www.revealweb.org.uk/
RFB&D http://www.rfbd.org/
Tech Classics Archive http://classics.mit.edu/
The Blind Bookworm http://www.panix.com/~kestrell/sources.html
The Sound of Literary 
Works

http://verkaro.com/audio/doku.php

Unabridged: Digital 
Audio Books

http://unabridged.lib.overdrive.com/

University of Adelaide 
Library

http://etext.library.adelaide.edu.au/

University of California 
Press

http://texts.cdlib.org/escholarship/titles_public.
html

University of Virginia http://etext.lib.virginia.edu/
Victorian Women Writer’s 
Project

http://www.indiana.edu/%7Eletrs/vwwp/
vwwp%2Dlibrary.html

Wowio Free Books http://www.wowio.com/

Online Reference Resources
Category Type Web Site
Dictionary Dictionary www.dictionary.com 
Dictionary All Words http://www.allwords.com/
Dictionary Cambridge 

Dictionaries Online
http://dictionary.cambridge.org/

Dictionary Children’s 
Dictionary

http://www.wordsmyth.net 

Dictionary Confusing Words www.confusingwords.com,
Dictionary Encarta www.encarta.com
Dictionary Explanations of 

Technical Terms
http://whatis.techtarget.com/

Dictionary MerriamWebster www.m-w.com 
Dictionary One Look www.onelook.com 
Dictionary Quotation 

Dictionary
http://www.askoxford.com

Dictionary Talking Dictionary 
Program for VI

http://www.talkingsoftware.gothere.
uk.com/ 
html/talking_dictionary.html
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Category Type Web Site
Dictionary Words Commonly 

Confused
http://homepage.smc.edu/reading_lab/
words 
_commonly_confused.htm

Dictionary Your Dictionary www.yourdictionary.com
General 
Reference

General Reference http://www.refdesk.com

http://www.ipl.org
General 
Reference

Information on 
Web-related Issues

http://webreference.com

General 
Reference

Purdue University 
Guides for Doing 
Research

http://www.lib.purdue.edu/rguides

General 
Reference

Research Site http://www.itools.com

Grammar Daily Grammar: http://www.dailygrammar.com/archive.
shtml

Grammar Guide to Grammar 
and Writing

http://webster.commnet.edu/grammar/
index.htm 

Grammar Hyper Grammar http://www.uottawa.ca/academic/arts/ 
writcent/hypergrammar/grammar.html

Grammar Knowing the Basics 
of Grammar

http://web.uvic.ca/wguide/Pages/
GrammarToc.html

Grammar Grammar Lists http://www.gsu.edu/~wwwesl/egw/grlists.
htm

Grammar Online Grammar 
References

http://www.andromeda.rutgers.edu/~jlynch/
Writing/ 
http://www.chompchomp.com/terms.htm

Grammar Online Writing Lab http://owl.english.purdue.edu/
Grammar Sentence Sense http://webster.commnet.edu/sensen/part1/

index.html
Grammar The Online English 

Grammar
http://www.edufind.com/english/grammar/

Grammar Reading/Writing 
Center Handouts

http://rwc.hunter.cuny.edu/writing/on-line.
html 

Legal Legislative Info http://thomas.loc.gov
Misc. Study Guides and 

Strategies
http://www.studygs.net/digital.htm

Thesaurus Online Thesaurus http://thesaurus.reference.com
Tutorials BrailleNote, etc. http://atto.buffalo.edu/registered/Tutorials.

php
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Category Type Web Site
Usage Online Usage Guide http://www.bartleby.com/usage/
Vocabulary World Net 

Vocabulary Helper
http://poets.notredame.ac.jp/cgi-bin/wn

Helpful link:

http://www.just-nothing.com/etext.html

Special Font
American Printing House for the Blind (APH) has created a special font for low 
vision readers: http://www.aph.org/products/aphont.html

APHontTM (pronounced Ay’-font), was developed by APH specifically for low 
vision readers. APHont embodies characteristics that have been shown to enhance 
reading speed, comprehension, and comfort for large print users.
Previously, the APHont Regular portion of the APHont Suite was available free 
of charge on a PC-formatted floppy disk. This disk has been discontinued, but 
the entire APHont Suite is now available free of charge on the APH web site. The 
APHont Suite consists of Regular, Bold, Italic, and Italic Bold. One must certify 
use for or by a person with a visual impairment before downloading.
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Features:
More even spacing between letters.
Higher crossbars.
No serifs.
Wider letters.
Heavier letters.
Underslung “j” and “q.”
Letters more open.
Larger punctuation marks.

Product Name
Price Vendor

Adobe Reader 8 Free www.adobe.com

Natural Reader Free www.naturalreaders.com

TextAloud $29.95 www.nextup.com

Speaking Notepad $29.95 www.qwertystudios.com

ReadPlease Plus $49.95 www.readplease.com

The E-text Reader 6.2 (Premiere) $49.95 www.readingmadeez.com

ReadingBar 2 $69.95 www.readplease.com




